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“Effective business systems are the most misunderstood and underutilized tools of 
the small-business owner. You are now on a journey of discovery that will forever 
change the way you do business. Only disciplined and systemized organizations will 
survive, compete, and prosper in an ever-demanding marketplace. Soon you will pos- 
sess what I call the Master Skill—the ability to develop highly-effective business sys- 
tems and processes that please customers, remove waste and inefficiency, and put 
more money in your pocket. This Quickstart Guide will get you going, but I invite you 
to commit time every day to ‘work on your business’ (Michael Gerber, “E-Myth”). In 
time, the results will amaze you, and you will have a remarkable company!” 

Introduction 

Items You Should Already Have 

10 Values of a Systems Thinker One-page pdf that will add clarity to your business perspective  

Better Systems - Better Business Eleven-page pdf primer on business systems 

Business Systems 101 “Become a Systems Thinker” (17-minute  video; show your employees) 

The Systems Thinker Newsletter Weekly email of tips, strategies, and best-practices to run a business 

Box Theory™ Software Tool Create smooth-running and efficient business systems and processes. 

Box Theory™ eCourse  “Double Your Profit  with High-Performance Systems and Processes” 

Software Tip (Installation Options) A series of  email tips to help you get the most out of your software. 

The Box Theory™ Business Systems Academy 

The Box Theory™ Business Systems Academy is an online curriculum for business owners and managers to 
become proficient at creating better business systems and processes. 

Course materials include: the eCourse (above), instructional    
videos for learning the software, and enrichment articles. The  
information and tips are presented in an orderly fashion to  
develop your skill to create effective business systems. 

The Academy is like taking a university course at your own pace. 
You will use this Master Skill throughout your business career. 

Click here to  go to the Academy Home 

Please  read this document on your  com-
puter with the Box Theory™ Software open. 

https://cdn2.hubspot.net/hub/60274/file-14902156-pdf
https://cdn2.hubspot.net/hub/60274/file-14888572-pdf
https://www.boxtheorygold.com/business-systems-webinar
https://www.boxtheorygold.com/free-information
https://www.boxtheorygold.com/get-software/
https://www.boxtheorygold.com/get-ecourse
https://www.boxtheorygold.com/box-theory-ecourse-and-software-installation
http://www.boxtheorygold.com/box-theory-business-systems-academy
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Mission and Purpose 

Our Mission and Purpose 

The Box Theory Way™ is designed to  help business owners and entrepreneurs: 

 Increase customer loyalty, profitability, and growth by elevating the performance of their vital business 
systems and processes.  

 Create a business culture of discipline and excellence that exceeds expectations and achieves maxi-
mum results even when the owner is not around.  

 Sell the business for top dollar, hire someone to run it, or replicate it in new markets, 
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Better Systems = Better Business 

The following fundamental principles will help you begin Systems Thinking, and discover a new way of running 
a business that gets exceptional results. 

What You Should Know About Business Systems and Processes 

 A business system is a procedure, process, method, or course of action designed to achieve a specific 
result that is consistent, measurable, and ultimately benefits customers. It can be as simple as a form 
or checklist, but always provides the best-known way to accomplish a reoccurring task. . 

 Effective systems and processes (e.g., lead generation, hiring, order-fulfillment, customer service, and 
many unique to your operation) are the fundamental building blocks of your company. They consist of 
larger activities, smaller tasks, and even smaller steps within each task. The sub-systems are more   
detailed and specialized.  For example, “interviewing job candidates” is a 
sub-system of “hiring” which is a sub-system of “Human Resource.” 

 The primary purpose of your business systems to find and keep custom-
ers, eliminate operational waste, and create differentiation and domina-
tion in your crowded marketplace. 

 Creating good business systems is the practical application of laws, 
principles and best practices—the Master Skill of the entrepreneur. All 
business functions—marketing, finance, and operations—fall within the 
scope of this single skill mastery. 

 Systems replace seat-of-the-pants operations—and everything left to 
chance—with detailed procedures, standards, and accountability. You 
are saying to your people, "This is how we do it here!" 

 Effective business processes provide quality, efficiency, and low-cost 
products and services, giving customers the best value and stakehold-
ers the greatest return. 

 Like a recipe, there are only two ways to improve a system or process: 1) Improve the procedure or 
steps in the process or 2) improve the component parts or ingredients used in the process.  

 Putting ordinary people into well-designed systems yields extraordinary results; "let systems run the 
business and people run the  systems” (Michael Gerber, “E-Myth”). 

 Ongoing system development promotes continuous learning, growth, and improvement of individuals 
and organizations; innovation at the system-level drives all progress.  

 The financial benefit of good business systems far exceeds the cost of their development; the payoff is 
often immediate and dramatic. The true long-term value of a business is found in the maturity of its 
business systems and processes—their ability to consistently produce desired results. 

“At its core, a 
fully functioning 
business is ba-
sically a set of 
systems and 
process.” — John 

Jantsch, Duct Tape 
Marketing 
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The Box Theory Way™ 

The Box Theory Way™ is a unique methodology that incorporates powerful principles into a software tool for 
creating and improving business systems and processes. It is designed for the small and midsize business. 

Simply Put,  A Box is a Business Activity, System or Process 

 The Box Theory™ method consists of breaking your business down into 
bite-size and manageable systems and processes, the repetitive activities 
you do every day to get work done in sales, operations, and administration. 

 A variety of terms are used when speaking of routine business activities. In 
Box Theory™, each term—a task, procedure, or step of a process—refers to 
a BOX. The Box Theory Way™ focuses on improving the vital few BOXES 
(systems and sub-systems) that are most responsible for your success,.  

 Your business is made up of many systems and process-
es. Each  consists of larger activities, smaller tasks, and even 
smaller steps within each task. Every activity, task, and step 
can be represented by a BOX on an organization chart or pro-
cess flowchart. Every BOX is of greater or lesser value to your 
organizational strategies and goals, and currently produces 
results that are either acceptable or unacceptable. 

 BOX THEORY™, (the actual theory), is this: If you can de-
termine the vital few BOXES that cause your key business outcomes, and elevate them to higher per-
formance levels, the effect will be greater customer loyalty, profitability, growth, and overall business 
success. (See further explanation and examples) 

 The Box Theory Way™ allows any organization to be viewed as a collection of individual BOXES. Focus-
ing on a single essential BOX quickly reveals the root-cause of frustration and problems as well as their 
obvious solutions. It shines a light on the critical details where problems and profits are generated.  

 In Box Theory™ Software, seven high-performance attributes are potentially associated with a business 
system/BOX. Each attribute is a quality that improves the output of the system. Thus, you can elevate 
the performance of any system—or BOX—by taking steps to increase the number of its high-
performance attributes. For example, if the business system has an owner with accountability, it will 
achieve far better results than a system without an owner. (See other six attributes; bottom of page) 

 For a more complete understanding of how BOXES are used, click here. (This linked information will also 
come to you later as one of the “Software Tips”)  

https://www.boxtheorygold.com/box-theory-business-systems-academy
https://www.boxtheorygold.com/box-theory-what-is-it
https://www.boxtheorygold.com/box-theory-what-is-it
https://www.boxtheorygold.com/box-theory-all-about-boxes
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The Software Features 

Below is a brief overview of the features of Box Theory™ Software .   

For more detailed information click here (scroll down) 

Please Watch Video!.  

You will learn more about the 
software in 11 minutes than 
anything else you can do. 

Click Here for 
Software Tour 

http://www.boxtheorygold.com/is-box-theory-gold-software-right-for-you
http://www.boxtheorygold.com/box-theory-gold-software-tour
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The Software Home Page 

Every time you open the software you are first taken to the HOME page, You can also return to this page from 
anywhere in the software by clicking on the “HOME” button in the upper left corner of the page. More infor-
mation is available for each section of the HOME page (see page 26 below). Note 1: The “T” at the top of the 
“Recent Documents” section below will take to you the Document Template Manager. Note 2: Much of the 
functionality of the software is accessed by right-clicking your mouse-button on the text or in a space.. 
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Your Organization Blueprint 

It is a good idea to create an operational business plan (different than a plan for investors or bankers) that will 
allow you to create systems and processes that are aligned with your mission, vision, strategy and goals. The 
software will help people and systems push together to accomplish the vision and goals of your organization. 
The Organization Blueprint is accessed from the Main Menu and each of the ten steps is listed in the left-side 
Navigation Panel. The Action Plan button at the bottom of screen is where you do all your planning work in 
each of the ten sections. 

“A good plan is like a road map: it shows the final destination and 
usually the best way to get there”  — H. Stanley Judd, “Think Rich” 

http://www.boxtheorygold.com/mission-statement
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Plan Your First Boxes 

The Last two steps of the Organization Blueprint are the beginning of your work with BOXES. They include the 
Organization Chart and the System Framework. The Organization Chart is a high-level view of your organiza-
tion’s major activities (e.g., marketing, operations, administration). In the System Framework, you identify your 
major systems and sub-systems by name.  Prioritizing your system-development work will allow you to focus 
on the systems easiest to implement and with the biggest payoff. (See “Software Help”  button for prioritizing.) 

http://www.boxtheorygold.com/business-systems-framework
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Create Box Theory™ Systems 

The Six Elements of Every Business System or Process 

1. Process 

Are your core processes—whether in the office, the store, the workshop or the 
factory—mapped or flowcharted? Are they smooth-running, with minimal bot-
tlenecks and downtime, and with few mistakes or rework required. Does your 
customer—either directly or indirectly—benefit by each step in the process? 

2. Components 

Do you have all of the forms, checklists, scripts, reports, brochures, databases, 
equipment, software, tools, supplies, and everything necessary for workers to 
make the system operate effectively? Missing or underperforming compo-
nents are the cause of many weak business systems. 

3. People 

Are your people the right fit for their job? (People are components, too.) How 
good are your hiring, training and communication systems? Do your systems 
include elements of accountability and motivation? Blame poor systems be-
fore you blame people. Effective business systems leverage ordinary people to 
produce extraordinary results. 

4. Quality 

Are your products or services delivered as promised? Do they meet customer 
specifications and expectations? Does your process have minimal mis-
takes, waste, rework or returns that drive up cost? Anything "critical to quality" 
for the customer should be important to you, or they will shop elsewhere. 

5. Speed 

Is the System efficient? Are workers productive? Do customers get served fast 
or on time? Could you reduce waiting time, delays, "speed bumps" and bottle-
necks in your process? Speed increases customer satisfaction, productivity, 
sales capacity, and cash flow cycles, while lowering costs. Improving the 
throughput of products and services will drive growth and profitability. 

6. Measurement 

    More Tools 

Do you manage by the numbers? Do you measure performance of your core 
business systems? Continuous measurement and feedback drive all process 
improvement. Establish measurements that let you know every day how you 
stand in relation to your business goals. Strive to better your best. 

Like a recipe, there are only two ways to get better results from any business system—improve the procedure 
or improve the component parts (ingredients). Using Box Theory™, you will know exactly how to create, diag-
nose problems, or improve any business process. With each System/BOX in the software, you will address six 
areas of focus with tools for each on the Taskbar. They are described below with links to software screenshots. 

"If you can't describe what you are doing as a process, you don't know what you're 
doing.“— W. Edwards Deming, Total Quality Management. 

 

 

 

 

 

 

 

 

 

 

https://www.boxtheorygold.com/business-process-tools
https://www.boxtheorygold.com/system-components-tools
https://www.boxtheorygold.com/people-and-team-tools
https://www.boxtheorygold.com/quality-improvement-tools
https://www.boxtheorygold.com/speed-improvement-tools
https://www.boxtheorygold.com/measurement-tools
https://www.boxtheorygold.com/more-software-tools
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The Taskbar and Toolbar 

Most of your work in Box Theory™ Software  is accessible from one or two menu bars at the bottom of the 
Task Window (the large main window). Below is a brief  review. 

System Taskbar – In “Box Theory™ Systems” on the Main Menu,  there are specific things you can do—Action 
Plans—to create or improve the selected System in the Navigation Panel (orange background). Simply choose 
what aspect of the System/BOX you want to work on—Process, Components, People, Quality, Speed or Meas-
urement. The down-arrow opens a list of available Action Plan tools as pictured below for “Process.” 
 

 
Help Toolbar – The Help Toolbar is below the Taskbar when working on your business systems. The buttons 
provide options that will help you in the process of creating your Organization Blueprint or creating and        
improving a System/BOX. The tools are described as follows: 

 Principles – This includes the foundation principles you should understand and apply to the System,/
BOX you are working on. It is the related chapter contained in the Box Theory™ eCourse. 

 Action Plan —  In the “Organization Blueprint,” this button is where you do your planning. In “Box Theo-
ry™ Systems,” the entire upper Taskbar is a series of Action Plans for each of the six areas of focus.  

 Examples – This shows a real-world example of a completed Action Plan page, including the System 
Dashboard, Process, Components, People, Quality, Speed or Measurement. 

 Worksheet – This is an exercise available in some sections to stimulate your thinking and help you pre-
pare for completing the Action Plan. In some cases, the “Worksheet” is a tool for developing supple-
mental information such as a budget. Worksheets are helpful, but optional. 

 System Notes – You will often get ideas while you are working on a system. "System Notes" is a text 
editor that allows you to jot down your thoughts or ideas for future reference. 

 Video Help – For some sections of Box Theory™ Software, a screen-capture video will give you visual 
instructions or walk you through a process. The videos may be slightly different than what you encoun-
ter as occasional changes and improvements are made to the software. 

 Software Help – This is the primary written instruction and help pertaining to the functionality of a spe-
cific section of the software. “Software Help” is available in the Organization Blueprint, but particularly 
useful in the Box Theory™ Systems area. I recommend you look here for quick answers to questions. 
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Managing Sub-systems (1) 

Box Theory™ is unique in its ability to recognize the importance of sub-systems and sub-processes. The daily 
work going on in your business consists of larger activities, smaller tasks, and even smaller steps within 
each task (like a paragraph > sentence > word > letter). Marketing, for example, is a high-level business activi-
ty or system. Within marketing, you will likely have a system for generating sales leads. Within the Lead-
Generation system, you may have tasks or sub-systems such as Telemarketing, Direct Mail, and Radio Ad-
vertising. In Box Theory™, you only work on the lowest-level System/BOX required to get the desired result. In 
the image below, Direct Mail is the focus of attention. Root problems are found in the details of these lower-
level sub-systems which become increasingly specialized as they cascade down through the organization.  

After clicking "Box Theory™ Systems" on the Main Menu, you will see the Navigation Panel on the left side of 
your screen (see image on next page). Consistent with Box Theory™ logic, each BOX is a system and contains 
lower-level BOXES or sub-systems.  

The image on the next page, shows the Navigation Panel with the Company BOX on level 1 (Roman numeral I). 
On level 2, you see the department name (Operations). On level 3, you see the System that is being worked on—
Manufacturing (orange background). On level 4,  you see the steps within that System. If you want to work on 
the “Paint” system for example, just double-click on Step 3, and it will become the current System, (orange 
background). If you want to work on a different system in the Operations Department, double-click on the de-
partment and below it will display other Systems such as Customer Service or Shipping/Receiving.  

"In order for any business to succeed, it must first become a system so 
that the business functions exactly the same way every time down to the 
last detail." — Rick Harshaw, “Monopolize Your Marketplace” 

Continued Page 14 
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Managing Sub-systems (2) 

When working on a business System/BOX, it is sometimes desirable to see what is going on at other levels. 
Wherever you see the “Level-viewer Tool” (shown below) you can click on any of the levels for a different view. 
For example, if you wanted to see all the documents used in Lead Generation, you could click on the next level 
down to see a list that also includes the documents for Radio Advertising, Direct Mail, and Telemarketing. As 
you become familiar with the software, this tool will be handy to see more or less information. The Level-viewer 
is described more fully in the “Software Help” wherever the tool is displayed. 

Don’t Forget to Right-Click 

By right-clicking your mouse in the Navigation Panel and most other sections of  the software, a pop-up list will 
indicate the actions you can take, such as adding, renaming, deleting, moving, and so forth. 

When you add a System/BOX in the Navigation Panel, the System Framework is also updated. In fact, when a Sys-
tem/BOX is added, modified or deleted anywhere,  all other areas of the software are automatically updated. 
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Getting-Started Checklist (1) 

First Things First  

 Install Box Theory™ Software and eCourse, and register your activation key. If you haven’t already, sign up 
for “The Systems Thinker” newsletter. Add us to your contacts, address book, or safe-senders list. Read 
this document and explore the links. Spend time each day at the Business Systems Academy. Complete 
your Organization Blueprint and then begin to create or improve your first business systems. 

 Find a quiet time and place—preferably in the early-morning—to study and work on improving and building 
value into your people, products and processes.  Focus on how you can please customers, encourage 
learning and growth of employees, eliminate waste and inefficiencies, and increase profitability. 

  Become a Systems Thinker; look at everything in your business from a systems perspective. Use custom-
er or employee feedback, performance data, and personal frustration to guide your problem-solving activi-
ties. Remember: every thing you learn from experience, system feedback, worker suggestions, outside con-
sultants, personal study, or seminars and workshops, is of no value unless you go back to Box Theory™ Soft-
ware and modify a procedure or component part. This is the only way to improve any business. 

 If you have a system-improvement team, the business owner often takes the lead. He or she is responsible 
for all improvement projects and has the authority to make decisions for the company. Other managers 
can play a role on the team; however they should also be Systems Thinkers! 

 Create a regular time and location—at least weekly—for a System Improvement Workshop. Discuss with 
your team ways to innovate and achieve better results. Focus on one or two systems at a time. 

Create Your Organization Blueprint 

 Lay the foundation for creating your business systems and processes by completing the 10-step Organiza-
tion Blueprint (Main Menu bar of the software). Steps 1-7 include your mission, values, vision, what your 
customers and employees expect from you, your unique game-plan or strategy, and your company goals.  

 Create an Organization Chart for your company (Step 9). This visual description of the structure and rela-
tionships within the organization is your most fundamental business system, and your first BOXES. All oth-
er Systems/BOXES fall within a specified job functions on this chart. 

 Complete the System Framework (Step 10) to identify the names of the major systems in your company. 
In Box Theory™ Software, Level 1 is your company name. Level 2 are the several general department 
names from your org chart. Add other primary systems to level 3 and maybe level 4 (see the Examples 
page at the bottom of the Task Window). You now have the skeleton/framework for your business. You 
can add, delete, or modify the System Framework later, so just get it roughed in when doing the Organiza-
tion Blueprint. Determine each system’s Priority Score and select the first system you want to create or 
improve. The "Software Help" at the bottom of the page will explain the simple scoring system. 

Continued Page 16 

https://www.boxtheorygold.com/free-information
https://www.boxtheorygold.com/box-theory-business-systems-academy
https://www.boxtheorygold.com/blog/bid/122954/Business-Startup-Your-First-Business-Systems-and-Processes
https://www.boxtheorygold.com/blog/bid/115801/Work-ON-the-Business-7-Tips-to-Do-It-Right
https://www.boxtheorygold.com/blog/bid/12990/Are-You-a-Systems-Thinker
https://www.boxtheorygold.com/blog/bid/57859/Your-First-Business-Improvement-Workshop
https://www.boxtheorygold.com/mission-statement
https://www.boxtheorygold.com/mission-statement
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Developing High-Performance Systems 

 From the priority score in the System Framework, choose a system to create or improve. Start by develop-
ing or improving the business systems that have the biggest payoff—those that are essential to your suc-
cess or obstacles in your path. Systems that help you find and serve customers are high priorities. Focus 
efforts on one or two systems only for fastest results. Then move on to others. 

 Select “Box Theory Systems” on the Main Menu. In the left Navigation Panel, double-click on the listed 
“Activity,” “System,” or “Step” until you find the name of the system you want to work on (they are in the 
same order you created them in the System Framework). Double-click on a “Step” to make it the current 
“System” (orange background). This is the System/BOX you will now create or improve. 

 Once you have chosen a system to work on, you will perform the actions at the bottom of the Task Win-
dow. There are six major areas to consider. In “Process," you will create a flowchart, checklist, or both to 
describe the specific steps in the business system or processes. Next you will identify and acquire the ma-
jor “Components” that are necessary to make the system work effectively (e.g., documents such as a form, 
contract, spreadsheet, or brochure, and software, equipment, materials, supplies, and so forth). 

 In the Box Theory™ Gold version, you will also add ‘People,” teams, and policies. In addition, there are tools 
to diagnose problems with system “Quality” or “Speed” (efficiency), and to determine action plans for im-
provement. Finally, in the Gold and Silver versions, you can create performance-measurement reports in 
minutes. Note: you only use the software tools you need to get the desired results for each System/BOX. 
Print checklists or any resource documents for people to use during operation. It’s all easy and logical. 

 Elevate system-performance over time by applying the “7 High-Performance Attributes” (e.g., increase qual-
ity and speed; eliminate bottlenecks, and so forth). (See “Box Theory™  - What is It?”; bottom of page) 

Getting-Started Checklist (2) 

Continued Page 17 

https://www.boxtheorygold.com/box-theory-what-is-it
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Other  Notes Of Interest 

 About 20% of your System/BOXES have the most influence on your business results.  Determine the vital 
few BOXES that drive the success of your business and elevate those BOXES to higher-performance levels. 

 Many systems can be created quickly and are as simple as a checklist. Others are more complex and bet-
ter displayed using a flowchart. However, good systems are as simple as possible to get the desired result.  

 Acquiring all the necessary system components is usually the most time-consuming and sometimes ex-
pensive part of creating a new system. List the major components needed for each step in the process. 
(e.g., form, checklist, equipment, supplies, etc.). Assign people to find, create, or buy them.. 

 If you are working on systems with a team or in your weekly business improvement workshop, you can 
easily whiteboard the system procedure or steps, identify the major components for each step, and get the 
information into the software while the meeting is in progress. With discussion this may take up to an hour. 

 When whiteboarding a system flowchart, keep in mind that every process has a specific starting point and 
ending point—boundaries. Begin by identify the first and last step of the process you are working on. Be 
sure you don't overlap steps with other systems. A system generally has only one measurable goal. If there 
is more than one objective, you have probably combined multiple systems.  

 To avoid missed expectations and wasted time, anyone working on business systems should get approval 
from the person in authority for the system design and budget before beginning implementation. 

 Get employee buy-in to a new system by including them in the development process. Teach the team how 
the new system will work and what is expected of them. Perform any formal training that would improve 
their skills. Deploy the system with careful orchestration of people and resources to get people off to a 
good start and avoid natural resistance.. Be sure that your customers are not adversely affected during the 
transition. Continue to operate the system the same way every time until you discover a "new best way." 

I hope I haven’t included too much detail in this Quickstart Guide. While it may seem overwhelming, I assure 
you that it will soon become “second nature”, and like most skills, you will do it without even thinking about it. 
In fact, you are doing most of it already and just don’t realize it. Also, don’t forget to see the principles, examples, 
worksheets, and the software and video help. “A picture or example is worth a  thousand words.” 

EXPECT A BIG PAYOFF.  AND REMEMBER, “THERE IS NO OTHER WAY!” 

 

 

Getting-Started Checklist (3) 

"Organize around business functions, not people. Build systems within each busi-
ness function. Let systems run the business and people run the systems. People 
come and go but the systems remain constant." - Michael Gerber, “E-Myth” 

https://www.boxtheorygold.com/blog/bid/57859/Your-First-Business-Improvement-Workshop
https://www.boxtheorygold.com/blog/bid/25647/Four-Easy-Steps-to-Creating-a-New-Business-System
https://www.boxtheorygold.com/blog/bid/111360/Process-Improvement-The-Rules-of-Engagement
https://www.boxtheorygold.com/blog/bid/23621/Four-Stages-to-Becoming-a-Systems-Thinker
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Final Comment 

No matter what size your business, what industry you are in, or whether your operation is in the office, the 
store, the workshop or the factory,  your customers, employees, and stakeholders (YOU) will ALL benefit by 
your effort to create exceptional business systems and processes.  It’s a WIN-WIN-WIN. 

I recommend you set aside at least 60 minutes every day to work in 'The Zone" on your business. There is no 
better use of your time than building long-term value into your people, products and processes. The Box Theo-
ry Way™ is not just about learning principles; it is about applying principles for measurable improvements. It’s 
about developing real systems and processes that enable you to please customers, retain good employees, 
make money, and build a company you can be proud of. 

There is a lot of helpful information in this Quickstart Guide and the other resources listed on page 3; however,     
system development is really quite simple and intuitive.  Here it is in a nutshell. 

1. A business consists of a collection of systems (BOXES) for getting work done. 

2. 20% of the BOXES have the most influence on your business results (80-20 Rule). 

3. Identify and prioritize these vital few or under-performing BOXES (in the System Framework). 

4. Elevate the performance of your critical BOXES by applying the 7 high-performance attributes 
(using the tools in Process, Components, People, Quality, Speed, and Measurement).. 

5. Continue improvement until desired results are achieved. 

Like any skill, a little time and determination will reap enormous benefits. But, since you HAVE to develop good 
business systems anyway, Box Theory™ Software will  cut your time in half and give you the very best result.   

Start with the Organization Blueprint, have fun, and let me know if there is anything I can do to help! 

https://www.boxtheorygold.com/blog/bid/116918/Business-Improvement-Get-Off-the-Treadmill-and-Into-the-Zone
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Appendix

The following Appendix includes the four general Help topics available from the Main Menu of the software, 
This information covers some of the less-obvious aspects of the Box Theory™ Software,. While the Appendix 
may be a little dense to read, I recommend you at least skim over the topics to know what is there. You will
pick up some useful information that will enhance your experience with this powerful software tool.

Below are also some links to articles and web pages might quickly expand your understanding of the Box The- 
ory™ principles and software. However, much of this information will come to you in time via the “Software 
Tips” and weekly newsletter.

ENRICHMENT ARTICLES, TIPS , OTHER RESOURCES (most items below are in the downloaded content)

Product Installation and Other Software Tips

Box Theory™: All About Boxes

Your First Business Improvement Workshop

10 Values of a Systems Thinker!

Four Stages to Becoming a Systems Thinker

Business Owners: Your Role in Creating Remarkable Business Systems

Business Startup: Your First Business Systems and Processes

The Art and Science of System Building

10 Easy Steps to Grow the Perfect Business - Table of Contents

Box Theory™ Business Systems Academy (a self-paces learning  center )

Box Theory™ Gold or Box Theory™ Silver Features and Benefits (look below the slideshow)

Frequently Asked Questions (fourteen answered questions you may find helpful)

Success Stories (examples of improved business systems)

What Customers Are Saying (a few comments from those who have experienced the Box Theory™ Way)

Quotes about Business Systems (what experts say about business systems & processes)

Better Systems = Better Business (getting-started primer for better business systems & processes; 11-pg pdf)

Box Theory™ Software Tour ( an 11 minute overview of the software.)

Business Systems 101 Webinar (17-minute video "Become a Systems Thinker"; show your employees)

All Wealth is Based Upon Systems (6-minute video with four BIG Ideas)

Box Theory™ Small-Business Advisor (become a heroic small-business coach) 

https://www.boxtheorygold.com/software-tips
https://www.boxtheorygold.com/box-theory-all-about-boxes
https://www.boxtheorygold.com/blog/bid/57859/Your-First-Business-Improvement-Workshop
https://www.boxtheorygold.com/blog/bid/10851/10-Values-of-a-Systems-Thinker
https://www.boxtheorygold.com/blog/bid/23621/Four-Stages-to-Becoming-a-Systems-Thinker
https://www.boxtheorygold.com/blog/bid/108926/Business-Owners-Your-Role-in-Creating-Remarkable-Business-Systems
https://www.boxtheorygold.com/blog/bid/122954/Business-Startup-Your-First-Business-Systems-and-Processes
https://www.boxtheorygold.com/the-art-and-science-of-system-building
https://www.boxtheorygold.com/blog/bid/118384/10-Easy-Steps-to-Grow-the-Perfect-Business
https://www.boxtheorygold.com/box-theory-business-systems-academy
https://www.boxtheorygold.com/is-box-theory-gold-software-right-for-you
https://www.boxtheorygold.com/is-box-theory-silver-software-right-for-you
https://www.boxtheorygold.com/box-theory-faq
https://www.boxtheorygold.com/business-systems-success-stories
https://www.boxtheorygold.com/what-customers-are-saying-about-the-box-theory-way
https://www.boxtheorygold.com/quotes-about-business-systems
https://cdn2.hubspot.net/hub/60274/file-14900726-pdf/content-pdf/bpm_better_systems-better_business.pdf?t=1490821006176
https://www.boxtheorygold.com/box-theory-gold-software-tour
https://www.boxtheorygold.com/business-systems-webinar
https://www.boxtheorygold.com/business-systems
https://www.boxtheorygold.com/small-business-advisor
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Appendix 1.1: Software Main Menu 

MAIN MENU OPTIONS 

The "Main Menu" bar across the top of Box Theory™ software displays tasks you can perform within the soft-
ware. With each selection, the Navigation Panel and/or the Task Window change to provide the desired work-
ing environment. The Navigation Panel, on the left side of your screen, shows the tasks or boxes you can work 
on. The Task Widow—the main part of the screen—is the actual working area. Below are general descriptions 
of each item on the Main Menu 

File – You can use Box Theory™ Gold Multi-Company version for an unlimited number of organizations. More 
than one company can also be open at the same time. If so, you will see a Box Theory™ icon for each open 
company on your Windows task bar. In the Multi-Company version, select "New" to set up a new organization 
and "Open" to load any of your existing organizations. At first launch, the program automatically opens to the 
organization you were working in last. You can also do a "Save As" to create a whole new organization with the 
same Organization Blueprint, System Framework, and all components—a duplication of the database. For easy 
access, up to six recent company files are displayed from the menu. (Box Theory™ Gold and Silver are limited 
to one organization and database. Therefore, the "New," "Save As," and "Open Recent" buttons do not appear.) 

In the File area, you can also Export or Import all or part of your Organization Blueprint to and from another Box 
Theory™ company database. The exported file has a ".blu" file extension."  Note:  Of the ten Organization Blue-
print Action Plans, you can only Export and Import the first nine. You cannot export/import the System Frame-
work because it is deeply integrated into each unique company database.  

File > Administration – The Administration area provides a dialog box with tabs for performing various admin-
istrative tasks. They are as follows: 

 People – Add the names of people (a few or everyone) in your organization to a company roster. The 
names will show up in several places of the software on a drop-down list for creating system teams or 
assigning job descriptions. 

 Backup– Box Theory™ Software continually saves your company database while you are working. It also 
allows for a backup database to be created each day that you are in the program. You can click the 
“Backup Now” button on the right side of the Main Menu at any time to perform a manual save of your 
company’s backup database. It’s a good idea to do this occasionally throughout the day. You are also 
prompted to back up the database when you exit the software. 

Box Theory™ Software puts backup files of your company database in the “BTG Backup” folder located 
in your company folder—YourCompanyName (BTG). The file extension for all company database files is 
".btg."  
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 Box Theory™ Software creates one backup file with your company name and today’s date every day you 
are in the program. If you uncheck the box, "Delete Old Backup Files," an unlimited number of daily back-
up files is maintained. If the box is checked (by default), files are saved for the three most recent days 
and a week apart for approximately a month. You will have up to eight backup files on your computer at 
one time. In File > Administration > Backup, select "Open Folder" to view your backup files. You can de-
lete files manually at any time. 

 Restore – Under the Restore tab, you will see a list of available backup files and dates. Select, open, and 
verify the file you want to restore. Then simply click the button on the Main Menu that says, “Restore 
Open Backup." This will make the open backup file your current company database. It will also rename 
the old company folder with today’s date. When satisfied, you can delete the old folder and its contents.  

Restoring a Component Document Only – If you have a lost or corrupted document file (Word, Excel, 
PowerPoint, etc.) that you need to restore from a backup database, you can quickly do it from within the 
current active database. Right-click in the Component Manager. Go to "Import Document > “Restore 
Document from Company Backup Database.” Select the system and then the document to restore. Click 
“OK” to import the document into the current system. You may need to rename it. 

Restoring  a System/BOX Only – When you have a company backup file open, you can select a System/
BOX in the System Framework and export its entire contents. Then import it into your current company 
database. This is a fast way to restore a single system. You can then delete the old System/BOX that 
you are replacing 

Preferences –  By default, the English Spellcheck is enabled. You can switch to the Spanish Spellcheck 
or disable Spellcheck altogether. Because a lot of "loose" writing is possible in the Notes area, spellcheck 
can be disabled to avoid frequent red-underline words. 

Edit – This standard menu item allows you to undo, select, cut, copy, and paste text. These functions also ap-
pear on the Toolbar at the bottom of the Task Window. You can use Ctrl-Z (undo), Crtl-A (select), Crtl-C (copy), 
Crtl-X (cut), and Crtl-V (paste) anywhere within a text box. 

Find – Search your organization database by selected categories or all categories using a keyword 
search. Each search will bring up a list of the items that meet the search criteria. The search will look for a 
string of characters that match the keyword search criteria (e.g., if you search for improv, it will bring up hits 
such as improve, improving, improvement). If you put quotation marks around several words, it will find all oc-
currences of that exact phrase (e.g., "quality and efficiency"). Keywords are highlighted and shown within con-
text. Double-click to go to that document or area of the software. In addition, you can create your own personal 
Bookmarks for quick access to anywhere in the software. Right-click on the bookmark to rename or delete it. 

Appendix 1.2: Software Main Menu 

Continued Page 22 



 22 

 22 

 

 

Print – Printing goes above and beyond in Box Theory™ Software. You can print any page or document as you 
normally would print with the document open, or from the “Print Current Page” area of the Main Menu. 

You can also print an entire group of perfectly formatted documents such as the ten parts of your Organization 
Blueprint. What's more, you can print a Systems Document with all of its component parts such as the 
flowchart, checklist, policies, job descriptions, and measurement reports, as well as the documents you have 
created in Word or Excel—all with a single click on the "Print" button. 

Because there are potentially many printable pages and documents within the software, you have two ways to 
narrow down the number of items you print in a Systems Document. When you create a flowchart, checklist, 
component document or measurement report, you are given a checkbox (upper-right corner) to “Include in 
Printing.” When this box is left unchecked, your supporting, secondary, or incomplete documents will not be 
included in the System Document. 

Secondly, when printing the multi-part Organization Blueprint or the Systems Document in the “Print” wizard on 
the Main Menu, press the "Document Options" button to select the specific documents that you want to in-
clude or exclude. Checked boxes will print; unchecked will not. Use the level-viewer to also include documents 
in the lower-level sub-systems. With the print wizard, you can completely customize your major documents. 

Note 1: Sometimes you may want a document to start at the top of a new page to prevent it from spanning 
multiple pages. If so, click on the checkbox until a dark square fills the box. This tells the printer to start the 
document at the top of the next page. You can use the "Show Preview" button to see how your complete docu-
ment will look and make necessary adjustments before actually printing the entire document. 

Note 2: In a typical system, you may also have several documents you would print as part of the “System Doc-
ument” such as forms, reports, and so forth. These documents are often given to the system operators to carry 
out their jobs. However, many documents listed in the Component Manager are likely to be resource or sup-
porting information you don’t want to print as part of the System Document. For those documents that you 
want printed, check the box, “Include when Printing System Document. This check-box is found when creating 
or editing the document (In the Component Manager, right-click on the document and select "Edit Component 
Info. See the printing check-box at the bottom of the dialog window.)  

Note 3: Be sure to set the level-viewer in the upper-right  corner of the Document Options  to include all the doc-
uments that you want to print. Remember that the number of documents grows exponentially as you include 
more levels. The print preview will tell you how many pages will be printed. Remember: Any flowcharts or 
checklists that are to be printed must have the "Include in Printing" box checked at the top of the flowchart or 
checklist page. In addition, when printing a checklist, you have the option of embedding sub-checklists into the 
primary checklist, or printing them separately. 

The printing feature alone will save you hours of finding, gathering and organizing documents. It is a powerful 
tool, designed to make your life easier. 

Appendix 1.3: Software Main Menu 
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Help – There are a variety of sources to help you implement the principles of Box Theory™ and Box Theory™ 
Software. By selecting "Help > Help Content" from the Main Menu, you will see several general help documents. 
Please refer to the document, "Help Resources," to learn the various types of help contained within the soft-
ware. From the "Help" button, you can also "Submit a Bug" or suggestion for a software enhancement. 
In "About Box Theory™ Software," you can verify whether you have the Gold, Silver or Multi-Company edition, 
and see the last update and version number of your software. 

Organization Blueprint – Begin defining your business with the Organization Blueprint. This ten-step section 
will help you define who you are, where you are going, and how you are going to get there. The ten steps, as 
seen in the Navigation Panel, will take you through Mission, Values, Vision, Voice of the Customer, Voice of the 
Employee, SWOT Analysis, Strategy, Balanced Scorecard (goals), Organization Structure, and the System 
Framework. The Organization Blueprint ensures that the systems you develop will drive your company n the 
direction of your vision and  goals. 

Box Theory™ Systems– Selecting this option will load your systems in the Navigation Panel on the left of your 
screen and prepare you for creating or improving individual Systems/BOXES. This is the heart of Box Theory™ 
Software  and will be where you spend most of your time.  

Once you select a System/BOX to work on, you will go to the "Taskbar at the bottom of the Task Window. 
There you will select tasks to develop or refine a system—Process, Components, People, Quality, Speed or 
Measurement. The System Dashboard and High-Performance Attributes provide summary information about 
the system.  

After selecting the System/BOX, you will use the Toolbar below it for help in accomplishing your system devel-
opment work. The buttons provide Principles, Examples, Worksheets, System Notes, Video Help and Software 
Help. See the next section of this document or the software Main Menu > Help > "Navigating Box Theory™ Soft-
ware" for more information about each of these buttons. LINK…………….. 

System Framework – You will complete the System Framework as the last step of the Organization Blueprint. 
However, this is the one place in the software that you can see all of your systems in a Microsoft-style directo-
ry tree. You can also view development priorities and your progress with the High-Performance Attributes. This 
option is located on the Main Menu for quick access to your all of your organization's Systems/BOXES. 

Measurement Reports– From this drop-down list, you can quickly access the measurement reports created by 
the Report Wizard or the Spreadsheet Reports you have created using a Microsoft Excel. Select the report 
name and open it for viewing or data entry. For quick data entry, this Main Menu list includes all measurement 
reports you have created. 

Appendix 1.4: Software Main Menu 
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Appendix 2.1: Software Navigation 

 

BOX THEORY™ LOGIC 

After clicking "Box Theory™ Systems" on the Main Menu, you will see the Navigation Panel on the left side of 
your screen. Box Theory™ Software navigation follows the Box Theory™ logic. That is, each box is a system 
and contains lower BOXES or sub-systems. You can drill down from the top of the organization to the lowest 
BOX or sub-system within the organization. The list of systems or BOXES that you see in the Navigation Pan-
el is what you added in the Systems Framework section of the Organization Blueprint. You can add more BOX-
ES (systems) at any time. The Task Window is the large center window where you will do most of your work.  

NAVIGATION GUIDELINES 

Finding a System/BOX – You can find the System/BOX you want to work on in five different ways: 
 

1.    Double-click (or right-click menu) on a System/BOX name in the System Framework 
2.    Drill down and select a System/BOX in the Navigation Panel. 
3.    Search for a System/BOX by keyword from the Main Menu > Find > Search 
4.    Go to a system from a custom Bookmark you set up from the Main Menu > Find 
4.    Select a BOX you were recently in by using the "Recent Places" button. 
5.    Use the "Forward-Backward Arrows" to move to places visited in the current session. 
6.    Click on the System/BOX name on your Home page list of Favorite Systems. 
(You'll probably get into a habit of using a couple of these methods.) 

Navigation Bar – Just above the Navigation Panel and below the Main Menu is a short menu bar called the 
"Navigation Bar." The two arrows allow you to go backward or forward on the Task Window in similar fashion 
to a web browser. The "Recent Places" button shows a list of places you have recently been working. By select-
ing a System/BOX from the list you will be taken directly to that System/BOX. You can also access your Home 
page from anywhere in the software by clicking on the "HOME" button. 

Navigation Panel – Beginning with the Company box on level 1, the Navigation Panel shows a direct line down 
the levels of the organization to the System/BOX you want to work on. The view consists of general business 
"Activities," the "System" or BOX you are currently working on, and the "Steps" within that system.  Each is de-
scribed further below. 

Activities – The Activities section shows the hierarchy of BOXES as you drill down from the top of the organi-
zation to the System/BOX you have selected to work on. As you go deeper into the organization, a Roman nu-
meral appears to the left indicating the level of each activity (see "Levels" below). The BOXES in the Activities 
area provide a frame of reference and enable you to move up or down the organization in a direct line. 
System – The System section is the box you are currently working on (orange background). When you create 
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a flowchart or checklist, add components, or other work in the Task Window, this is the specific box that all of 
your work applies to. You can make any box the current System by double-clicking on it, or by right-clicking and 
choosing "Select as Current System." 

Steps – The Steps are what you must do to operate the System named above. If the order is important, you 
can think of these steps as a procedure. If the order is not important, they are tasks on a checklist, either of 
which you will eventually develop in more detail. If you double-click on a Step, it will become the current Sys-
tem (orange background) and show its individual steps on the list below. 

Levels – By default, the top BOX in any organization—Level I—is the "Company." This is the only BOX that can-
not be deleted; Level II is the "Department" level, having names like Sales, Operations, Finance, or Administra-
tion. You will discover that most system development takes place on levels 3-5. However, you can go as deep 
as you want to perfect even the smallest details. 

Plus (+) – When you see a plus sign on the left side of a box in the Navigation Panel, that means that there are 
lower-level Steps/BOXES within that box. If there is no plus sign, you have reached the last Step/BOX in the 
down-line. There are no deeper levels of activity described as of yet. 

Right-Click Menus – By right-clicking your mouse, in the Navigation Panel and other sections of Box Theory™ 
software, a pop-up list will indicate the actions you can take, such as adding, renaming, deleting, or other ap-
propriate functions. 

Select as Current System – Double-click your mouse on any BOX to make it the current System. You can also 
right-click and choose to "Select as Current System."  

Add, Rename, Delete a BOX –. Right-click on a System or Step to edit its "Name" or "Purpose/Description." You 
can also add or delete a Step. Caution: Deleting a BOX will delete everything associated with it such as 
flowcharts, component documents, etc. 

Naming a BOX – The name of a System/BOX is a brief description of its role as the step of a process. You can 
put up to six lines of text in a flowchart box. The name should be descriptive enough to understand the system; 
however, it is best to use as few words as possible. You can add any amount of detail in the Purpose/
Description of the System.  A high level BOX could just be named “Hiring,” while a lower-level more detailed 
BOX (sub-system) may be named “Interview the Job Candidate.”  

Purpose/Description – The Purpose/Description of a BOX is a statement that further describes the role or pur-
pose of the BOX as a step in a process or task on a checklist. It is a way to provide more information beyond 
the name itself.  Note: You may also want to describe in the Purpose/Description the steps or tasks in the next 
level down to avoid having to actually create and work on those BOXES individually.  
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Moving a BOX – To move a Step up or down the list, select the Step with the left mouse button and drag it to 
the desired position. This will enable you to re-order the steps in your procedure. You cannot drag a Step out-
side of the current System of steps. However, from within the System Framework on the Main Menu, you can 
right-click and move the BOX to another location in Box Theory™ Software using the Microsoft-style directory 
tree. 

Resulting Actions – When you add a System/BOX in the Navigation Panel, the System Framework is also up-
dated. In addition, the new BOX is placed on your Flowchart grid and added to the Checklist. In fact, when 
a System/BOX is added, modified or deleted anywhere in the software, all other areas are updated. 

HOME PAGE 

When you first load the software, the "HOME" page is displayed in the Task Window. The Home page displays 
information that you can customize for personal use. The following "gadgets" are displayed. 

Favorite Systems – When you create a new System/BOX, you have a check-box option to display the system 
name on the Home page for easy access. Systems listed on the Home page may be your organization's core 
systems, the systems you are the owner of, or systems that you frequently work on. You decide. By clicking on 
the system name, its Dashboard page is displayed in the Task Window. By right-clicking on the system name, 
you can go directly to a work area of the system such as "Components," or "System Checklist." 

Favorite Systems are automatically listed under tabs with department names you created. If the department 
name is long, you can right-click to edit it. For example, You could change "Administration" to "Admin," or 
"Marketing and Sales" to just "Marketing," just "Sales," or "M & S." Shorter tabs allow more space for the list be-
low. Note: These name abbreviations do not alter actual department names found elsewhere in the software.  

Web Links – Create links to your favorite websites that can help you with system development work such as 
vendors, customers and other business resources. You can also launch your email program from here. 

Recent Documents – Go directly to the most-recent documents you have accessed in your Component Man-
ager. (This list is refreshed each time you open the HOME page.) Click on the "T" button to go to the Template 
Manager, a repository for storing document variations, obsolete documents you don't want to discard, or fre-
quently used document formats and templates. 

Calendar – Check dates going infinitely forward or backward. 

Systems Thinking Tips — Each time you go to the HOME page you will see a new thought, tip, or quote that 
may prompt you in your system development work. By clicking the "All" button, you can scroll up or down the 
list to see thoughts of the past or those coming in the future. Click again to return to the current tip. 
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Performance Indicators – When you create a new measurement report, you have a check-box option to identify 
it as a Key Performance Indicator (KPI). Measurement reports that track KPIs are listed here along with current 
data. You can open the report by clicking on the report name. 

Notes/Videos/eCourse  –  In the left Navigation Panel,  you can create any number of categories or subcatego-
ries of notes, to-do lists, and so forth. Right-click to add, rename, and delete. You can also drag the notes to 
change their order on the list. Keep in mind that there is a separate place for "System Notes" pertaining to an 
individual System/BOX. The "Video Tutorials" button provides single-point access to all help videos presented 
throughout the software. The eCourse button displays the entire book, “Box Theory™: Double Your Profit with 
High-Performance Systems and Processes.” 

OTHER NAVIGATION TOPICS 

The Taskbar and the Toolbar (described on page  12) 

The  Level-viewer (described fully in the “Software Help” wherever the tool appears on a page). 

Appendix 2.4: Software Navigation 

"94% of all failure is a result 
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Appendix 3.1 Working With Files 

 

COMPANY FILES 

An activation key is required for each separate installation of the Box Theory™ software. The soft-
ware database is one file with the extension .btg (Box Theory Gold). All your work to create an Organization 
Blueprint and Box Theory™ Systems is contained within this file. The .btg file is automatically backed up and 
can easily be restored from earlier versions (see “Backup and Restore” below). 

When you first enter Box Theory™ software, you are asked to provide a company name. The name of your 
company is also the name of your .btg file and the name of the folder it is stored in on your hard drive. If you 
modify the name of your company, your .btg file and company folder will automatically be renamed. By default, 
your company folder is created in the “Documents” or “My Documents” folder of your computer, depending on 
your operating system.  

Insides your company folder are several other folders. The “BTG Backup” folder contains your backup files. 
Other folders such as “Text,” “Spreadsheet,” and so forth, contain copies of the component documents you 
have created using Microsoft Office or Open Office (see “Component Document Files” below). 

Whether you have Box Theory™ Gold, Multi-Company, or the Silver edition, the database file is the same. If you 
begin with Box Theory™ Silver, you can upgrade to Box Theory™ Gold and maintain all of your current data. To 
verify what edition you are using, go to the Main Menu and select "Help." You will either see "About Box Theo-
ry™ Gold” or "About Box Theory™ Silver" at the bottom of the menu. 

The primary difference between the Gold and Multi-Company editions is that Gold only works with one compa-
ny file while the Gold Multi-Company edition supports unlimited company files. In the Silver edition, the 
“People,” “Quality” and “Speed” areas of the Taskbar are also disabled. The Silver edition is scaled down in this 
way for smaller or start-up companies. 

COMPONENT DOCUMENT FILES 

One of the unique features of Box Theory™ software is its ability to manage all your component documents. 
Currently, the software officially supports Microsoft Office and Open Office products such as Word, Excel, Pub-
lisher and PowerPoint; however, you can also import other document types, such as a .pdf file, and open them 
from within the software. 

In order to organize your business documents—like they have never been organized before—we have created a 
file structure within the software database (.btg file) that tracks every document you create and the business 
system it is associated with. Your documents are created, stored, and retrieved from within the “Component 
Manager” of the Box Theory™ Systems area. 

Your documents are also duplicated on your hard drive in the company folder--the same folder that contains your Box 
Theory™ company database, or .btg file.  
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Document File Types – In the company folder of your hard drive, you will see folders such as Text, Spread-
sheet, Graphic, Database, Pdf, Template, Other, and Temp. These folders contain copies of the documents you 
created in Box Theory™ Software. They are organized by file types instead of systems. For example, Microsoft 
Word files and Open Office Writer files are stored in the Text folder. Files of any type that are displayed in the 
Template Manager of the software are stored in the “Template” folder. These folders only appear as you create 
specific file types. For example, if you never use Microsoft Access, the “Database” folder will not be listed. 

Important Note: If you discontinue using Box Theory™ software, you have easy access to all the files you created us-
ing this software program. 

Synchronization – Box Theory™ software regularly synchronizes its database with the duplicate files on your 
hard drive. If you update a file in Word, for example, outside of Box Theory™ software, the synchronization will 
update the file within the software the next time you open it. 

If you lose a file on the hard drive, Box Theory™ Software will copy it back during the synchronization. If you 
add a new file to your company folder, and Box Theory™ Software doesn’t know what system it belongs to, it 
will put the file in the Template Manager, and you can later add it to a specific system. 

You don’t really have to worry about managing any of this; it all happens behind the scenes. Synchronization 
takes place when you open and close the software, and it checks at intervals while you are working. All you 
need to know is that you have an extra copy on your hard drive of every document you created in your compa-
ny database. 

Note:  It is a good habit to access your Microsoft document files from within the software and to close any 
open Word or Excel documents, for example, before exiting the software. If you happen to exit the software and 
discover that you still have an open and unsaved document, just save it as usual. The synchronization process 
will update the file inside the software the next time you load it. 

Keep in mind that if you create a document and save it somewhere on your hard drive other than in your com-
pany folder, it will not be known to Box Theory™ Software and not included in the synchronization process. Box 
Theory™ only knows what is in your company database (.btg) and the company folder on your hard drive.  

Importing Documents – When importing document files from your hard drive into your Component Manager, 
you should avoid bringing large multi-media files. These file types often exceed computer memory and will 
abort, or if they do import, will bloat the database and slow performance. Simply put, your Box Theory™ compa-
ny database can handle standard business document files—even large ones—without a problem, but don’t bog 
it down with extra-large media files. 

Appendix 3.2 Working With Files 
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Linking to External Documents – If you do have a large file that you want to associate with a system, you can 
right-click from within the Component Manager and create a link to the file on your hard drive, Google docs, or 
Dropbox. The document will load and run from within the Component Manager just like your other documents; 
however, it will not be saved inside your company database (.btg) or duplicated in the company folder. In the 
Component Manager, a linked file will display the name followed by "(link)." 

Unique Document Names – Document files in Box Theory™ Software must have unique names, even if the 
same document is used in a different system. If you are attempting to name a file that is already in your com-
pany database, you will be prompted to give it a new name. It can be only slightly different. 

COLLABORATION AND NETWORKING 

The Box Theory™ database file can only be opened by one user at a time. However, it is currently recommend-
ed that one or two designated people become experts with the software.  

Note: To prevent problems of overwriting data, the database is locked to others when one user has the soft-
ware open. Simple scheduling will allow more than one person to work on the same database. 

While it is encouraged for team members to “rough in” a system flowchart using a whiteboard, a person who is 
familiar with Box Theory™ Software will be the most efficient at developing and refining the final system docu-
ments. 

If you have more than one person working in Box Theory™ Software, I recommend that the software be in-
stalled on a file server or in a peer-to-peer networking arrangement where both people have access to the 
same database file. For a second user installation within your company, you can request another activation key 
at no additional charge. With the proper setup, you could also access Box Theory™ software on your business 
file server from your home computer. 

It is also possible with the second activation key to have two separate installations on different computers—
each having its own company database. Some people have successfully installed to a thumb drive and moved 
the company database between computers. Be sure the thumb drive is present before the software is 
launched and not removed until the software is closed.  

If someone other than the business owner does most of the work in Box Theory™ software, they can periodical-
ly email the owner an updated version of the .btg file. When going back and forth, be sure that the most updat-
ed .btg file is emailed and copied over the older one. 

Upon completion of a single system, a person could also export and email a System/BOX (.box file) with all of 
its components (e.g. flowchart, checklist, documents, measurement reports) to another person for importing 
into their database. Finally, all or selected parts of the Organization Blueprint can be exported and imported 
between databases (.blu file). 

These are various ways you can work with a single company .btg file, or keep two separate files synchronized. 

Appendix 3.3 Working With Files 

https://www.boxtheorygold.com/blog/bid/25647/Four-Easy-Steps-to-Creating-a-New-Business-System
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Appendix 4: Help Resources 

 

SOURCES FOR HELP 

Box Theory™ is a new way of looking at your business, a new way of thinking. Even though the methodology is 
simple and tasks are easy to perform, we realize that it will be a new experience for you. For this reason, we 
provide a great deal of help. Below are the sources you can turn to for instruction and examples. 

Main Menu Help – From the Main Menu, you can view all the help found in the Appendix of this document.. 

Software Help Button – At the bottom of the Task Window in each section of the software, there is thorough 
help for the specific tool or topic. These help areas deal primarily with software functionality—how Box Theo-
ry™ Software works. 

Video Help Button – The video help provides brief on-screen examples of how to use a specific software tool. 
The "Video Help" button on the Taskbar or "Video Help" tab on the HOME page, will show the video through a 
web browser. The videos may be slightly different from the current version of the software.. 

Principles Button – In each section of the software, you have access to the underlying principles for building 
your organization and its systems. Most of the "Principles" pages are taken from the eCourse,  “Box Theory™: 
Double Your Profit with High-Performance Systems and Processes.” They include instruction and strategy per-
taining to the specific software task you are working on. You can also view the entire eCourse from the Navi-
gation Panel, "eCourse" button on the HOME page. 

Example Page Button – You will perform the important business-building tasks of Box Theory™ software on 
the "Action Plan" page of the Taskbar located at the bottom of the Task Window. The "Examples" page shows 
a real-world example of the Action Plan. Examples come from a variety of industries and business types.  

Worksheet Button – Worksheets are available in some sections to get you thinking and brainstorming about a 
specific task. In some cases, Worksheets provide a foundation for completing the Action Plan. In other cases, 
they are a tool for producing supplemental information. Worksheets are optional to completing the Action Plan 

Spell Checker (File > Admin > Preferences) – A spell checker (English or Spanish) will help you polish your doc-
uments for distribution. When you see a red line under a word you've typed, the dictionary thinks it is mis-
spelled. Right-click to see word options or to add the word to your personal dictionary. You can also turn it off. 

Box Theory™ Business Systems Academy – We recommend that you learn about Box Theory™ principles and 
software together by following the training program available at the Box Theory™ Business Systems Academy. 

Software Tips – Every few days for several months after purchasing to Box Theory™ software you will receive 
tips to enhance your experience. You can access all of these tips at BoxTheory™ Software Tips. 

https://www.boxtheorygold.com/software-tips
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Most entrepreneurs are not familiar with the powerful business improvement techniques and strategies used 
by larger companies. The Box Theory™ method transforms these often complex and expensive Business Pro-
cess Management (BPM) principles into simple and intuitive solutions for busy owners and managers on a lim-
ited budget. When applied, these principles can make your company remarkable! 

Appendix 5: Business Improvement 

Copyright © 2008 by Ronald G. Carroll 
All rights reserved. 
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